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Overview

Feather is the new development board from Adafruit, and like it's namesake it is thin, light, and lets you fly! We designed Feather to be a new
standard for portable microcontroller cores.

This is the Adafruit Feather 32u4 Bluefruit - our take on an 'all-in-one' Arduino-compatible + Bluetooth Low Energy with built in USB and battery
charging. Its an Adafruit Feather 32u4 with a BTLE module, ready to rock! We have other boards in the Feather family, check'em out
here (http://adafru.it/jAQ)

Bluetooth Low Energy is the hottest new low-power, 2.4GHz spectrum wireless protocol. In particular, its the only wireless protocol that you can
use with iOS without needing special certification and it's supported by all modern smart phones. This makes it excellent for use in portable
projects that will make use of an iOS or Android phone or tablet. It also is supported in Mac OS X and Windows 8+

At the Feather 32ué4's heart is at ATmega32u4 clocked at 8 MHz and at 3.3V logic, a chip setup we've had tons of experience with a#'s the same
as the Flora (http://adafru.it/dVI). This chip has 32K of flash and 2K of RAM, with built in USB so not only does it have a USB-to-Serial program &
debug capability built in with no need for an FTDI-like chip, it can also act like a mouse, keyboard, USB MIDI device, etc.
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To make it easy to use for portable projects, we added a connector for any of our 3.7V Lithium polymer batteries and built in battery charging. You
don't need a battery, it will run just fine straight from the micro USB connector. But, if you do have a battery, you can take it on the go, then plug in
the USB to recharge. The Feather will automatically switch over to USB power when its available. We also tied the battery thru a divider to an
analog pin, so you can measure and monitor the battery voltage to detect when you need a recharge.
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Here's some handy specs! Like all Feather 32u4's you get:
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Measures 2.0" x 0.9" x 0.28" (51mm x 23mm x 8mm) without headers soldered in
Light as a (large?) feather - 5.7 grams

ATmega32u4 @ 8MHz with 3.3V logic/power

3.3V regulator with 500mA peak current output

USB native support, comes with USB bootloader and serial port debugging
You also get tons of pins - 20 GPIO pins

Hardware Serial, hardware 12C, hardware SPI support

8 x PWM pins

10 x analog inputs

Built in 100mA lipoly charger with charging status indicator LED

Pin #13 red LED for general purpose blinking

Power/enable pin
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e 4 mounting holes
e Reset button

The Feather 32u4 Bluefruit LE uses the extra space left over to add our excellent Bluefruit BTLE module + two status indicator LEDs

The Power of Bluefruit LE

The Bluefruit LE module is an nRF51822 chipset from Nordic, programmed with multi-function code that can do quite a lot! For most people, they'll
be very happy to use the standard Nordic UART RX/TX connection profile. In this profile, the Bluefruit acts as a data pipe, that can 'transparently’
transmit back and forth from your iOS or Android device. You can use our iOS App (http://adafru.it/iCi) or Android App (http://adafru.it/f4G), or write
your own to communicate with the UART service (http://adafru.it/iCF).

The board is capable of much more than just sending strings over the air! Thanks to an easy to learrAT command set (http://adafru.it/iCG), you
have full control over how the device behaves, including the ability to define and manipulate your own GATT Services and

Characteristics (http://adafru.it/iCH), or change the way that the device advertises itself for other Bluetooth Low Energy devices to see. You can
also use the AT commands to query the die temperature, check the battery voltage, and more, check the connection RSSI or MAC address, and
tons more. Really, way too long to list here!

Use the Bluefruit App to get your project started

Using our Bluefruit iOS App (http://adafru.it/iCi) or Android App (http://adafru.it/f4G), you can quickly get your project prototyped by using your iOS
or Android phone/tablet as a controller. We have a color picker (http://adafru.it/iCl), quaternion/accelerometer/gyro/magnetometer or location
(GPS) (http://adafru.it/iCl), and an 8-button control game pad (http://adafru.it/iCl). This data can be read over BLE and piped into the ATmega32u4
chip for processing & control

You can do a lot more too!

e The Bluefruit can also act like an HID Keyboard (http://adafru.it/iOA) (for devices that support BLE HID)

e Can become a BLE Heart Rate Monitor (http://adafru.it/iOB) (a standard profile for BLE) - you just need to add the pulse-detection circuitry

e Turn it into a UriBeacon (http://adafru.it/iOC), the Google standard for Bluetooth LE beacons. Just power it and the 'Friend will bleep out a
URL to any nearby devices with the UriBeacon app installed.

o Built in over-the-air bootloading capability so we can keep you updated with the hottest new firmware(http://adafru.it/iOD). Use any Android
or iOS device to get updates and install them. This will update the native code on the BLE module, to add new wireless capabilities, not
program the ATmega chip.
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Comes fully assembled and tested, with a USB bootloader that lets you quickly use it with the Arduino IDE. We also toss in some header so you

can solder it in and plug into a solderless breadboard. Lipoly battery, MicroSD card and USB cable not included (but we do have lots of options
in the shop if you'd like!)
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Pinouts
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The Feather 32u4 Bluefruit LE is chock-full of microcontroller goodness. There's also a lot of pins and ports. We'll take you a tour of them now!
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The DFU pin is accidentally labeled GND on the bottom, sorry about that! it should be labeled DFU, dont use it as a GND

Power Pins
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e GND - this is the common ground for all power and logic

e BAT - this is the positive voltage to/from the JST jack for the optional Lipoly battery

e USB - this is the positive voltage to/from the micro USB jack if connected

e EN - this is the 3.3V regulator's enable pin. It's pulled up, so connect to ground to disable the 3.3V regulator
e 3V - this is the output from the 3.3V regulator, it can supply 500mA peak

Logic pins

This is the general purpose /O pin set for the microcontroller. All logic is 3.3V

e #0/RX- GPIO #0, also receive (input) pin forSerial1 and Interrupt #2

e #1/TX- GPIO #1, also transmit (output) pin forSerial1 and Interrupt #3

o #2/SDA - GPIO #2, also the 12C (Wire) data pin. There's no pull up on this pin by default so when using with 12C, you may need a 2.2K-10K
pullup. Also Interrupt #1

e #3/SCL- GPIO #3, also the 12C (Wire) clock pin. There's no pull up on this pin by default so when using with 12C, you may need a 2.2K-10K
pullup. Can also do PWM output and act as Interrupt #0.

e #5 - GPIO #5, can also do PWM output

e #6 - GPIO #6, can also do PWM output and analog inputA7

#9 - GPIO #9, also analog inputA9 and can do PWM output. This analog input is connected to a voltage divider for the lipoly battery so be

aware that this pin naturally 'sits' at around 2VDC due to the resistor divider

#10 - GPIO #10, also analog inputA10 and can do PWM output.

#11 - GPIO #11, can do PWM output.

#12 - GPIO #12, also analog inputA11

#13 - GPIO #13, can do PWM output and is connected to thered LED next to the USB jack

A0 thru A5 - These are each analog input as well as digital I/O pins.

SCK/MOSI/MISO - These are the hardware SPI pins,used by the Bluefruit LE module too! You can use them as everyday GPIO pins if

you don't activate the Bluefruit and keep the BLE CS pin high. However, we really recommend keeping them free as they should be kept

available for the Bluefruit. If they are used, make sure its with a device that will kindly share the SPI bus! Also used to reprogram the chip

with an AVR programmer if you need.

Bluefruit LE Module + Indicator LEDs
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Since not all pins can be brought out to breakouts, due to the small size of the Feather, we use these to control the BLE module

o #8 - used as the Bluefruit CS (chip select) pin
o #7 - used as the BluefruitIRQ (interrupt request) pin.
e #4 - used as the Bluefruit Reset pin

Since these are not brought out there should be no risk of using them by accident!

Other Pins!

e RST - this is the Reset pin, tie to ground to manually reset the AVR, as well as launch the bootloader manually

o ARef - the analog reference pin. Normally the reference voltage is the same as the chip logic voltage (3.3V) but if you need an alternative
analog reference, connect it to this pin and select the external AREF in your firmware. Can't go higher than 3.3V!

e DFU - this is the force-DFU (device firmware upgrade) pin for over-the-air updates to the Bluefruit module. You probably don't need to use
this but its available if you need to upgrade! Check out the DFU Bluefruit Upgrades page for how to use it. Otherwise, keep it disconnected.

On the back we also have SWDIO/SWCLK/RST pins, these are used for programming the Bluefruit LE module itself. You should not connect to
these, unless you want to wipe out the Bluefruit LE module firmware for some reason. The RST pin is the factory reset pin, which is also rarely
used, but you can use it to set the module back to the factory default settings if it gets really messed up.
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Assembly

We ship Feathers fully tested but without headers attached - this gives you the most flexibility on choosing how to use and configure your Feather

Header Options!

Before you go gung-ho on soldering, there's a few options to consider!

The first option is soldering in plain male headers, this lets you plug in the Feather into a
solderless breadboard
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Another option is to go with socket female headers. This won't let you plug the Feather
into a breadboard but it will let you attach featherwings very easily
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We also have 'slim' versions of the female headers, that are a little shorter and give a
more compact shape

LR B

Finally, there's the "Stacking Header" option. This one is sort of the best-of-both-worlds.
You get the ability to plug into a solderless breadboard and plug a featherwing on top.
But its a little bulky
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Soldering in Plain Headers

Prepare the header strip:

Cut the strip to length if necessary. It will be easier to solder if you insert it into a
breadboard - long pins down

Add the breakout board:

Place the breakout board over the pins so that the short pins poke through the breakout
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Solder the other strip as well.
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You're done! Check your solder joints visually and continue onto the next steps

Tape In Place

For sockets you'll want to tape them in place so when you flip over the board they don't
fall out
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Flip & Tack Solder

After flipping over, solder one or two points on each strip, to 'tack’ the header in place

And Solder!

Be sure to solder all pins for reliable electrical contact.

(For tips on soldering, be sure to check out ourGuide to Excellent
Soldering (http:/adafru.it/aTk)).
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You're done! Check your solder joints visually and continue onto the next steps
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Power Management

Battery + USB Power

We wanted to make the Feather easy to power both when connected to a computer as well as via battery. There'dwo ways to power a Feather.
You can connect with a MicroUSB cable (just plug into the jack) and the Feather will regulate the 5V USB down to 3.3V. You can also connect a
4.2/3.7V Lithium Polymer (Lipo/Lipoly) or Lithium lon (Lilon) battery to the JST jack. This will let the Feather run on a rechargable battery. When
the USB power is powered, it will automatically switch over to USB for power, as well as start charging the battery (if attached) at
100mA. This happens 'hotswap' style so you can always keep the Lipoly connected as a 'backup' power that will only get used when USB power is
lost.

The JS

== i

T connector polarity is matched t
L2 Ty

0 Adafruit LiPoly batteries. Using wrong polarity batteries can destroy your Feather
= \an s e e

T

The above shows the Micro USB jack (left), Lipoly JST jack (top left), as well as the 3.3V regulator and changeover diode (just to the right of the
JST jack) and the Lipoly charging circuitry (to the right of the Reset button). There's also a CHG LED, which will light up while the battery is
charging. This LED might also flicker if the battery is not connected.

Power supplies

You have a lot of power supply options here! We bring out theBAT pin, which is tied to the lipoly JST connector, as well asUSB which is the +5V
from USB if connected. We also have the 3V pin which has the output from the 3.3V regulator. We use a 500mA peak SPX3819. While you can gef
500mA from it, you can't do it continuously from 5V as it will overheat the regulator. It's fine for, say, powering an ESP8266 WiFi chip or XBee radio
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though, since the current draw is 'spiky' & sporadic.

Measuring Battery

If you're running off of a battery, chances are you wanna know what the voltage is at! That way you can tell when the battery needs recharging.
Lipoly batteries are 'maxed out' at 4.2V and stick around 3.7V for much of the battery life, then slowly sink down to 3.2V or so before the protection
circuitry cuts it off. By measuring the voltage you can quickly tell when you're heading below 3.7V

To make this easy we stuck a double-100K resistor divider on theBAT pin, and connected it to D9 (a.k.a analog #9 A9). You can read this pin's
voltage, then double it, to get the battery voltage.

#define VBATPIN A9

float measuredvbat = analogRead(VBATPIN);

measuredvbat *= 2; // we divided by 2, so multiply back
measuredvbat *= 3.3; // Multiply by 3.3V, our reference voltage
measuredvbat /= 1024; // convert to voltage

Serial.print("VBat: " ); Serial.printin(measuredvbat);

This voltage will 'float' at 4.2V when no battery is plugged in, due to the lipoly charger output, so its not a good way to detect if a battery is plugged
in or not (there is no simple way to detect if a battery is plugged in)

ENable pin

If you'd like to turn off the 3.3V regulator, you can do that with theEN(able) pin. Simply tie this pin toGround and it will disable the 3V regulator.
The BAT and USB pins will still be powered
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Arduino IDE Setup

The first thing you will need to do is to download the latest release of the Arduino IDE. You will need to be usingersion 1.6.4 or higher for this
guide.

Arduino IDE v1.6.4+ Download
http://adafru.it/f1P

After you have downloaded and installed v1.6.4, you will need to start the IDE and navigate to thePreferences menu. You can access it from the
File menu in Windows or Linux, or the Arduino menu on OS X.

& [[TIEY File Edit  Sketc

® About Arduino

Preferences... &8,

sket  Services >

void S¢

// pu Hide Arduino #BH un onc
Hide Others "\_3H
Show All

void 1¢

// pu QUit Al'dl.lino %Q In repe

A dialog will pop up just like the one shown below.

® Preferences

Sketchbook location:

[Users [todd/Documents /Arduino Browse
Editor language: = System Default s (requires restart of Arduino)
Editor font size: 10 (requires restart of Arduino)
Show verbose output during: compilation upload
Compiler warnings:  None .

Display line numbers
v Verify code after upload
Use external editor
v Check for updates on startup
v/ Update sketch files to new extension on save (.pde -> .ino)

v Save when verifying or uploading
Proxy Settings

Server (HTTP): Port (HTTP): 8080
Server: (HTTPS) Port (HTTPS): 8443
Username: Password:

Additional Boards Manager URLs: |

More preferences can be edited directly in the file
[Users (todd/Library/Arduinol5/ preferences.txt

(edit only when Arduino is not running)

OK Cancel

We will be adding a URL to the newAdditional Boards Manager URLs option. The list of URLs is comma separated, and you will only have to
add each URL once. New Adafruit boards and updates to existing boards will automatically be picked up by the Board Manager each time it is
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opened. The URLs point to index files that the Board Manager uses to build the list of available & installed boards.

To find the most up to date list of URLs you can add, you can visit the list otthird party board URLs on the Arduino IDE wiki (http://adafru.it/f7U).
We will only need to add one URL to the IDE in this example, but you can add multiple URLS by separating them with commas Copy and
paste the link below into the Additional Boards Manager URLs option in the Arduino IDE preferences.

https://adafruit.github.io/arduino-board-index/package_adafruit_index.json

e ¢ TR . =

Settings | Netwark |

Sketchbaok location:

C:\Users\adyada\Dropbox Ardui hes [ Browse
Editor language: |System Defauit = (requires restart of Arduina)

Editor font size: 12

Interface scale: (V] Automatic | 100 % (requires restart of Arduina)

Show verbose output during: 7] compiation (7] upload |
e ] .
[F] Display ke ruambers |
[ 7] Enable Code Folding

[] Verify code after upload

[ Use external editor

] Check for updates on startup

[] Update sketch files to new extension on save (.pde -> .ino)

[7] Save when verifying or
Additional Boards Manager URLs:§l https:/fadafruit.com fpackage_adafruit_index.json Iﬁ |

N the nie lEnlzr a comma searat!d list of urls

es. bt {

es can be edite:

Here's a short description of each of the Adafruit supplied packages that will be available in the Board Manager when you add the URL:

e Adafruit AVR Boards - Includes support for Flora, Gemma, Feather 32u4, Trinket, & Trinket Pro.

o Adafruit SAMD Boards - Includes support for Feather MO

e Arduino Leonardo & Micro MIDI-USB - This adds MIDI over USB support for the Flora, Feather 32u4, Micro and Leonardo using thearcore
project (http://adafru.it/eSl).

If you have multiple boards you want to support, say ESP8266 and Adafruit, have both URLs in the text box separated by a comma (,)

Once done click OK to save the new preference settings. Next we will look at installing boards with the Board Manager.
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Using with Arduino IDE

Since the Feather 32u4 uses an ATmega32u4 chip running at 8 MHz, you can pretty easily get it working with the Arduino IDE. Many libraries
(including the popular ones like NeoPixels and display) work great with the '32u4 and 8 MHz clock speed.

Now that you have added the appropriate URLs to the Arduino IDE preferences, you can open theBoards Manager by navigating to the Tools-
>Board menu.

Auto Format ®$T sketch_may07a | Arduino 1.6.4
Archive Sketch

Fix Encoding & Reload

Serial Monitor - 8M

Board: "Arduino Uno" > Boards Manager...
Pnrt | 3

Once the Board Manager opens, click on the category drop down menu on the top left hand side of the window and seled€ontributed. You will
then be able to select and install the boards supplied by the URLs added to the prefrences. In the example below, we are installing support
for Adafruit AVR Boards, but the same applies to all boards installed with the Board Manager.

Type Al L3 ¥ | |Filter your search

Arduino AVR Boards Buit-In by Arduine version 1.6.7 INSTALLED

Boards induded in this package:

Arduina Yan, Arduing Uno, Arduine Diecimila, Arduino Nana, Arduino Mega, Arduing MegaADK, Arduino Leonardo, Arduino Micro, Arduino Esplora,
Arduino Mini, Arduing Ethernet, Arduino Fio, Arduino BT, Arduino LilyPadUSB, Arduino Lilypad, Arduino Pro, Arduing ATMegaNG, Arduing Robot
Control, Arduing Robot Mator, Arduing Gemma.

Online helg

Mare infg

Arduino SAM Boards (32-bits ARM Cortex-M3) by Arduino
Boards included in this package:
Arduing Dise,

Bare info

Intel iS86 Boards by Intel
Boards included in this package:
Galileo.

Mare iofo

Next, quit and reopen the Arduino IDE to ensure that all of the boards are properly installed. You should now be able to select and upload to the

new boards listed in the Tools->Board menu.

Blink | Arduino 1.6.5

File Edit Sketch Help

Auto Format Ctrl+T

Archive Sketch

Fix Encoding & Reload o
Arduino Ethernet

Serial Monitor Ctrl+Shift+M
Arduino Fio

Board: "Arduino/Genuino Uno” Arduino BT

Port LilyPad Arduino USE

LilyPad Ardui
Programmer: "USBtinyISP" M (At I

Arduine Pro or Pro Mini

Arduino NG or older

Burn Bootloader

1 This example code is in the public domain. Arduino Robot Control

11 Arduino Robot Motor

12| modified & May Arduino Gemma

13| by Scott F s :

14| */ Arduino ARM (32-bits) Boards
15 Arduino Due (Programming Port)
18 Arduino Due (Native USB Port)
17 // the setup function runs conce when you press res i

18 void setup() { Adafruit Boards

19 // initialize digital pin 13 as an cutput. Adafruit Flora

20 pintods (13, OUTEUT): Adafruit Bluefruit Micro

21 )

f,,, ! Adafruit Gemma 8MHz

22

23 | // the loop function runs over and over again forey Adafruit Feather 32ud
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Install Drivers (Windows Only)

When you plug in the Feather, you'll need to possibly install a driver
Click below to download our Driver Installer

Download Adafruit Drivers Installer
http://adafru.it/mai

Download and run the installer

Opening adafruit_drivers.exe @

You have chosen to open:

=] adafruit_drivers.exe

which is: Binary File (13.6 MB)
from: https://github-cloud.s3.amazonaws.com

Would you like to save this file?

I Save File ] | Cancel |

%

Run the installer! Since we bundle the SiLabs and FTDI drivers as well, you'll need to click through the license

r 3
* Adafruit Board Drivers: License Agreement @_Ig
-

ﬁ FPlease review the license agreement before installing Adafruit board

drivers. If you accept all terms of the agreement, dick I Agree.

h’his program will allow you to install Windows drivers for =
hardware that Adafruit Industries produces. Please support |
Adafruit by purchasing hardware from:
<http://www.adafruit.com/>

Note you can uninstall any of the installed drivers by using
the Add/Remove Programs option in Control Panel (look for
the "Windows Driver Package' entries from Adafruit).

Cancel 1 Agree

Select which drivers you want to install:

r B
* Adafruit Board Drivers: Installation Options l = é]
-

%

Check the board drivers below that you would like to install. Click install to
start the installation.

Select board drivers to install:

m

Trinket / Pro Trinket / Gemma {(USBtinyI
[ Arduine Gemma B
] Feather HUZZAH ESP8256 (SiLabs CP2:

[ Metro 328 / Metro Mini 328 (FTDI VCP) ~
4 [l |

Cancel < Back | Install |

%

Click Install to do the installin'
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F "
3% Adafruit Board Drivers: Completed * EIEI&J

Completed

Show details |

Cancel | Mullsoft Install System v3.0b3 < Back

Blink

Now you can upload your first blink sketch!

Plug in the Feather 32u4 and wait for it to be recognized by the OS (just takes a few seconds). It will create a serial/COM port, you can now select
it from the dropdown, it'll even be 'indicated' as Feather 32u4!

la v
Blink | Arduino 1.6.5
-

File Edit Sketch Help

Auto Format Ctrl+T

Archive Sketch

Fix Encoding & Reload

Serial Monitor Ctrl+Shift+M

Board: "Adafruit Feather 32u4" »pe second, repeatedly.

Port Serial ports

Programmer: "USBtinylSP" COML (Adafruit Feather 32ud)
comi2

Burn Bootloader

COM105 (Adafruit Feather 32ud)

Now load up the Blink example

// the setup function runs once when you press reset or power the board
void setup() {

// initialize digital pin 13 as an output.

pinMode(13, OUTPUT);
}

// the loop function runs over and over again forever
void loop() {
digitalWrite
delay(1000
digitalWrite
delay(1000
}

13, HIGH); //turn the LED on (HIGH is the voltage level)

; // wait for a second

13, LOW); // turn the LED off by making the voltage LOW
) // wait for a second

And click upload! That's it, you will be able to see the LED blink rate change as you adapt thelelay() calls.

Manually bootloading

If you ever get in a 'weird' spot with the bootloader, or you have uploaded code that crashes and doesn't auto-reboot into the bootloader, click the
RST button to get back into the bootloader. The red LED will pulse, so you know that its in bootloader mode. Do the reset button press right as the
Arduino IDE says its attempting to upload the sketch, when you see the Yellow Arrow lit and the Uploading... text in the status bar.
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Don't click the reset button before uploading, unlike other bootloaders you want this one to run at the time Arduino is trying to upload

Ubuntu & Linux Issue Fix

Note if you're using Ubuntu 15.04 (or perhaps other more recent Linux distributions) there is an issue with the modem manager service which
causes the Bluefruit LE micro to be difficult to program. If you run into errors like "device or resource busy", "bad file descriptor", or "port is busy

when attempting to program then you are hitting this issue. (http://adafru.it/sHE)

The fix for this issue is to make sure Adafruit's custom udev rules are applied to your system. One of these rules is made to configure modem
manager not to touch the Bluefruit Micro board and will fix the programming difficulty issue. Follow the steps for installing Adafruit's udev rules on
this page. (http://adafru.it/iOE)
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Installing BLE Library
Install the Adafruit nRF51 BLE Library

In order to try out our demos, you'll need to download the Adafruit BLE library for the nRF51 based modules such as this one (a.k.a.
Adafruit_BluefruitLE_nRF51)

You can check out the code here at github, (http://adafru.it/f4V) but its likely easier to just download by clicking:

Download the Adafruit nRF51 BluefruitLE Library
http://adafru.it/f4W

Rename the uncompressed folder Adafruit_BluefruitLE_nRF51 and check that the Adafruit_BluefruitLE_nRF51 folder contains
Adafruit_BLE.cpp and Adafruit_BLE.h (as well as a bunch of other files)

Place the Adafruit_BluefruitLE_nRF51 library folder your arduinosketchfolder/libraries/ folder.
You may need to create thelibraries subfolder if its your first library. Restart the IDE.

We also have a great tutorial on Arduino library installation at:
http://learn.adafruit.com/adafruit-all-about-arduino-libraries-install-use (http://adafru.it/a¥YM)

After restarting, check that you see the library folder with examples:

(=2l sketch_may01la | Arduinc 1.6. Adafruit 9DOF

Edit Sketch Tools Help Adafruit ADS1015
New Ctrl+N Adafruit_ADXL345_U
Open... Ctrl+0 Adafruit_AHRS
Sketchbook Adafruit_AM2315
Adafruit_AS53935
Examples ) ;
Close CtrleW Adafruit_BLEFirmata
Adafruit_BLEModule_SPISlave
Save Ctrl+5
Adafruit_BluefruitLE_nRF51 atcommand
Save As... Ctrl+Shift+5 .
Adafruit_BMPOBS beacon
Upload Ctrl+U
ploat . Adafruit BMPO8S_Unified bleuart
Upload Using Programmer  Ctrl+Shift+U Adafruit_BMP183 factoryreset
Page Setup Ctrl+Shift+P Adafruit_ BMP183_Unified heartratemonitor
Print Ctrl+P Adafruit_BNOO055 hidkeyboard
Adafruit_CAP1188 -
Preferences Ctrl+Conmma I L IS

Run first example

Lets begin with the beginner project, which we can use to do basic tests. To open the ATCommand sketch, click on théile > Examples >
Adafruit_BluefruitLE_nRF51 folder in the Arduino IDE and selectatcommand:

Adafruit_AHRS >
Adafruit_BluefruitLE_nRF51 > atcommand
Adafruit_BMP085_Unified 2 beacon
Adafruit_BMP183_Unified_Library > bleuart
Adafruit_BNOO055 > factoryreset
Adafruit_CC3100 b heartratemonitor
Adafruit_DHT_Unified > hidkeyboard
Adafruit_DotStar > uribeacon
Adafruit_FONA_Library >

This will open up a new instance of the example in the IDE, as shown below:
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-
@ atcommand | Arduine 1.6.4 — - =B

File Edit Sketch Tools Help

atcommand

LAl
(Bfile atcommand. ino
Bauthor  hathach

R—TT—

This example shows how to comnect to your Adafruit Bluefruit LE (nrf51822) and do
gome bhasic AT commands to check connectivity, print out the wversion strings and let
you send your own AT commands'

*/

#include <string.hs

#include <Arduine.h>

#include <SPI.h>

#if not defined (_VARTANT_ARDUINO_DUE_X_)
finclude <SoftwareSerial.h>

dendif

#include "Adafruit BLE.h"
#include "Adafruit BLE_HWSPI.h"
#include "Adafruit BluefruitLE_UART.h"

/¢4 If you are using Software Serial....

J/ The following macros declare the pins used for 5V serial, you should

// use these pins if you are connecting the UART Friend te an UND

#define BLUEFRUIT SWUART REXD_PIN g /f Required for software serial!

LAndisme DITOEDIITT QUEIART TVR MTM 1 24 Poomadpsd Soy poSeszows sowdadl |
| i *

ne on COMZ54

Don't upload the sketch yet! You will have to begin by changing the configuration.
Go to the second tab labeled BluefruitConfig.h and find these lines

/| SHARED SPI SETTINGS
I
/I The following macros declare the pins to use for HW and SW SPI communication.
/I SCK, MISO and MOSI should be connected to the HW SPI pins on the Uno when
// using HW SPI. This should be used with nRF51822 based Bluefruit LE modules
// that use SPI (Bluefruit LE SPI Friend).

I

#define BLUEFRUIT_SPI_CS 8

#define BLUEFRUIT_SPI_IRQ 7

#define BLUEFRUIT_SPI_RST 6 // Optional but recommended, set to -1 if unused

And change the last line to:

#define BLUEFRUIT_SPI_RST 4 // Optional but recommended, set to -1 if unused
(The Bluefruit Feather has the reset on digital #4 not #6)

Now go back to the main tabatcommand and look for this line of code

/* ...hardware SPI, using SCK/MOSI/MISO hardware SPI pins and then user selected CS/IRQ/RST */
Adafruit_BluefruitLE_SPI ble(BLUEFRUIT_SPI_CS, BLUEFRUIT_SPI_IRQ, BLUEFRUIT_SPI_RST);

Make sure that the second line is uncommented (it should be)

OK now you can upload to the Bluefruit Feather!
If you're using Ubuntu 15.04 or other Linux distributions and run into errors attempting to upload a program to the board, scroll up to the Ubuntu
and Linux issue fix in the previous section

Uploading to the Feather Bluefruit LE

It's pretty easy to upload, first up make sure you haveAdafruit Feather 32u4 selected on the boards dropdown as above. Also, in thePorts menu,
look for the port labeled as such:
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r Blink | Arduino 165 —— —
File Edit Sketch Help

Auto Format Ctrl+T

Archive Sketch

Fix Encoding & Reload

1/ Serial Monitor Ctrl+Shift+M

Board: "Adafruit Feather 32ud” kpe
Port } Serial ports
COML (Adafruit Feather 32ud)
comi2
COM105 (Adafruit Feather 32ud)

Programmer: "USBtinyISP" }

Burn Bootloader

Now click the upload button on the Arduino IDE (orFile Menu -> Upload)

If all is good you will see Done Uploading in the status bar

F e T e E
atcommand | Arduinc 1.6.4 EI_IM

File Edit Sketch Tools Help

0 BHA

atcammand EluefruitConfig.h

18
]

lding all

Adafruit Bluefruit

Uploading to a brand new board/Upload failures

If you are uploading for the first time to a new board, or if upload fails, pres theRESET mini button on the Feather 32u4 Bluefruit when you see the
Yellow Arrow lit and the Uploading... text in the status bar. When you see the red LED pulsing on and off, you know the bootloader is running.
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File Edit Sketch Tools Help

atcommand

Adafruit Bluefruit b

Don't click the reset button before uploading, unlike other bootloaders you want this one to run at the time Arduino is trying to upload

Run the sketch

OK check again that the correct port is selected

r -
Blink | Arduino 1.6.5

. —

File Edit Sketch Help

Port

Auto Format
Archive Sketch
Fix Encoding & Reload

1y Serial Monitor

Board: "Adafruit Feather 32ud”

Ctrl+T

Ctrl+Shift+M

} Serial ports
COML (Adafruit Feather 32ud)
comi2
COM105 (Adafruit Feather 32ud)

Programmer: "USBtinyISP"

Burn Bootloader

Then open up the Serial console. You will see the following:

COMBS (Adafruit Bluefruit Micro)

=)

Cses |

RAdafruit Bluefruit AT Command Example

Initialising the Bluefruit LE module: OK!

Performing a factory reset:
AT+FACTORYRESET

<- OK
LTE=0

<- OK

Requesting Bluefruit info:
BLESFIFRIEND

nRF51822 QFACRIO0
6992R79TD32E2839

0.6.5

0.6.5

Jul 1 2015

5110 &.0.0, 0.2

Autoscroll

BothNL&CR v | 115200 baud
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This sketch starts by doing a factory reset, then querying the BLE radio for details. These details will be useful if you are debugging the radio. If
you see the information as above, you're working! (Note that the dates and version numbers may vary)

AT command testing

Now you can try out some AT commands - check the rest of the learn guide for a full list. We'll just start withAT+HWGETDIETEMP which will
return the approximate ambient temperature of the BLE chipset

.
COMGS (Adafruit Blusfruit Micro) [E=EEEE
AT+HWGETDIETEMP

Adafruit Bluefruit AT Command Example

Initialising the Bluefruit LE module: COK!
Performing a factory reset:
AT+FACTORYRESET

<- 0K
ATE=0

<- OK

Requesting Bluefruit info:
BLESFIFRIEND

nRF51822 QFACRIO0
6992R79T7D32E2839

0.6.5

0.6.5

Jul 1 2015

5110 &.0.0, 0.2

BothNL&CR v | 115200 baud

Performing a factory reset: -
AT+FACTORYRESET

<- OK
LTE=0

<- OK

Requesting Bluefruit info:
BLESFIFRIEND

nRF51822 QFACRIO0
6992R79T7D32E2839

0.6.5

0.6.5

Jul 1 2015

5110 &.0.0, 0.2

m

Autoscrol BothNL&CR v | 115200 baud

OK now you know how to upload/test/communicate with your Feather 32u4 Bluefruit. Next up we have a bunch of tutorials who can follow for checking out the bluetooth
le radio and apps.

For all the following examples, we share the same code between various modules so don't forget to make sure you have the RESET pin set to 4 in
BluefruitConfig.h for each sketch before uploading, and that Hardware SPI mode is selected by checking for

/*...hardware SPI, using SCK/MOSI/MISO hardware SPI pins and then user selected CS/IRQ/RST */
Adafruit_BluefruitLE_SPI ble(BLUEFRUIT_SPI_CS, BLUEFRUIT_SPI_IRQ, BLUEFRUIT_SPI_RST);
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Configuration!

Before you start uploading any of the example sketches, you'll need to CONFIGURE the Bluefruit interface - there's a lot of options so pay close
attention!

Which board do you have?

There's a few products under the Bluefruit name:

If you are using the Bluefruit LE Shield then you have anSPI-connected NRF51822
module. You can use this with Atmega328 (Arduino UNO or compatible), ATmega32u4
(Arduino Leonardo, compatible) or ATSAMD21 (Arduino Zero, compatible) and possibly
others.

Your pinouts are Hardware SPI, CS =8, IRQ =7, RST =4

Bluefruit Micro or Feather 32u4 Bluefruit

If you have a Bluefruit Micro or Feather 32u4 Bluefruit LE then you have an
ATmega32u4 chip with Hardware SPI, CS =8, IRQ =7, RST =4

¥ - '_,.‘i‘l- Sasi .
e Feather MO Bluefruit LE
If you have a Feather MO Bluefruit LE then you have anATSAMD21 chip with Hardware
SPI, CS =8, IRQ =7, RST =4

© Adafruit Industries https://learn.adafruit.com/adafruit-feather-32u4-bluefruit-le Page 37 of 133


https://learn.adafruit.com/assets/29590
https://learn.adafruit.com/assets/29592
https://learn.adafruit.com/assets/29698

Bluefruit LE SPI Friend

If you have a stand-alone module, you have a bit of flexibility with wiring however we
strongly recommend Hardware SPI, CS =8, IRQ =7, RST =4

You can use this with just about any microcontroller with 5 or 6 pins

Bluefruit LE UART Friend or Flora BLE

If you have a stand-alone UART module you have some flexibility with wiring. However
we suggest hardware UART if possible. You will likely need to use the flow controlCTS
pin if you are not using hardware UART. There's also a MODE pin

You can use this with just about any microcontroller with at least 3 pins, but best used
with a Hardware Serial/lUART capable chip!

Configure the Pins Used

You'll want to check the Bluefruit Config to set up the pins you'll be using for UART or SPI

Each example sketch has a secondary tab with configuration details. You'll want to edit and save the sketch to your own documents folder once

set up.

o
atcommand | A

[File Edit Sketch Tools Help

i BluefruitConfig.h
// COMMON SETTINGS
ryy
J/f These sectings are used in both 5W UART, HW UART and SPI mode

;

m

#define BUFSIZE 128  // Size of the read buffer for incoming data
#define VERBOSE_MODE ceue  // If sec to 'trus' enables debug output

// SOFTWAFE UART SETTINGS

R O L T LT T T T T T T Ty e e e S e e S e e
// The following macros declare the pins that will be used for 'SW' serial.

// You should use this option if you are connecting the UART Friend to an UNO

7 L = s Sz S 2 S

#define BLUEFRUIT_SWUART FXD_FPIN g // Required for software serial!
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Common settings:

You can set up how much RAM to set aside for a communication buffer and whether you want to have full debug output. Debug output is 'noisy' on
the serial console but is handy since you can see all communication between the micro and the BLE

I
// These settings are used in both SW UART, HW UART and SP| mode
Vi
#define BUFSIZE 128 // Size of the read buffer for incoming data
#define VERBOSE_MODE true // If set to 'true’ enables debug output

Software UART

If you are using Software UART, you can set up which pins are going to be used for RX, TX, and CTS flow control. Some microcontrollers are
limited on which pins can be used! Check the SoftwareSerial library documentation for more details

// SOFTWARE UART SETTINGS

#define BLUEFRUIT_SWUART_RXD_PIN 9 // Required for software serial!

#define BLUEFRUIT_SWUART_TXD_PIN 10 // Required for software serial!

#define BLUEFRUIT_UART_CTS_PIN 11 // Required for software serial!
#define BLUEFRUIT_UART_RTS_PIN -1 // Optional, set to -1 if unused

Hardware UART

If you have Hardware Serial, there's a 'name' for it, usually Serial1 - you can set that up here:
// HARDWARE UART SETTINGS
#ifdef Serial1  // this makes it not complain on compilation if there's no Serialt

#define BLUEFRUIT_HWSERIAL_NAME  Serial1
#endif

Mode Pin

For both hardware and software serial, you will likely want to define the MODE pin. There's a few sketches that dont use it, instead depending on
commands to set/unset the mode. Its best to use the MODE pin if you have a GPIO to spare!

#define BLUEFRUIT_UART_MODE_PIN 12 // Setto -1 if unused

SPI Pins

For both Hardware and Software SPI, you'll want to set theCS (chip select) line, IRQ (interrupt request) line and if you have a pin to spare,RST
(Reset)

/I SHARED SPI SETTINGS

#define BLUEFRUIT_SPI_CS 8
#define BLUEFRUIT_SPI_IRQ 7
#define BLUEFRUIT_SPI_RST 4 // Optional but recommended, set to -1 if unused

Software SPI Pins

If you don't have a hardware SPI port available, you can use any three pins...its a tad slower but very flexible

/| SOFTWARE SPI SETTINGS

#define BLUEFRUIT_SPI_SCK 13
#define BLUEFRUIT_SPI_MISO 12
#define BLUEFRUIT_SPI_MOSI 11

Refer to the table above to determine whether you have SPI or UART controlled Bluefruits!

Select the Serial Bus

Once you've configured your pin setup in the BluefruitConfig.h file, you can now check and adapt the example sketch.

The Adafruit_BluefruitLE_nRF51 library supports four different serial bus options, depending on the HW you are using:SPI both hardware and
software type, and UART both hardware and software type.

UART Based Boards (Bluefruit LE UART Friend & Flora BLE)

This is for Bluefruit LE UART Friend & Flora BLE boards. You can useeither software serial or hardware serial. Hardware serial is higher quality,
and less risky with respect to losing data. However, you may not have hardware serial available! Software serial does work just fine with flow-
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control and we do have that available at the cost of a single GPIO pin.

For software serial (Arduino Uno, Adafruit Metro) you should uncomment the software serial contructor below, and make sure the other three
options (hardware serial & SPI) are commented out.

// Create the bluefruit object, either software serial...uncomment these lines
SoftwareSerial bluefruitSS = SoftwareSerial( BLUEFRUIT_SWUART_TXD_PIN, BLUEFRUIT_SWUART_RXD_PIN);

Adafruit_BluefruitLE_UART ble(bluefruitSS, BLUEFRUIT_UART_MODE_PIN,
BLUEFRUIT_UART_CTS_PIN, BLUEFRUIT_UART_RTS_PIN);

For boards that require hardware serial (Adafruit Flora, etc.), uncomment the hardware serial constructor, and make sure the other three options
are commented out

/* ...or hardware serial, which does not need the RTS/CTS pins. Uncomment this line */
Adafruit_BluefruitLE_UART ble(BLUEFRUIT_HWSERIAL_NAME, BLUEFRUIT_UART_MODE_PIN);

SPI Based Boards (Bluefruit LE SPI Friend)

For SPI based boards, you should uncomment the hardware SPI constructor below, making sure the other constructors are commented out:

/* ...hardware SPI, using SCK/MOSI/MISO hardware SPI pins and then user selected CS/IRQ/RST */
Adafruit_BluefruitLE_SPI ble(BLUEFRUIT_SPI_CS, BLUEFRUIT_SPI_IRQ, BLUEFRUIT_SPI_RST);

If for some reason you can't use HW SPI, you can switch to software mode to bit-bang the SPI transfers via the following constructor:
/* ...software SPI, using SCK/MOSI/MISO user-defined SPI pins and then user selected CS/IRQ/RST */
Adafruit_BluefruitLE_SPI ble(BLUEFRUIT_SPI_SCK, BLUEFRUIT_SPI_MISO,

BLUEFRUIT_SPI_MOSI, BLUEFRUIT_SPI_CS,
BLUEFRUIT_SPI_IRQ, BLUEFRUIT_SPI_RST);
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BLEUart

The BLEUart example sketch allows you to send and receive text data between the Arduino and a connected Bluetooth Low Energy Central
device on the other end (such as you mobile phone using the Adafruit Bluefruit LE Connect application for Android (http://adafru.it/f4G) or
iOS (http://adafru.it/f4H) in UART mode).

Opening the Sketch

To open the ATCommand sketch, click on the File > Examples > Adafruit_BluefruitLE_nRF51 folder in the Arduino IDE and select
bleuart_cmdmode:

Adafruit_AHRS [ 2
Adafruit_BluefruitLE_nRF51 > atcommand
Adafruit_BMP085_Unified > beacon
Adafruit_BMP183_Unified_Library > bleuart
Adafruit_BNOO055 > factoryreset
Adafruit_CC3100 2 heartratemonitor
Adafruit_DHT_Unified > hidkeyboard
Adafruit_DotStar > uribeacon
Adafruit_FONA_Library >

This will open up a new instance of the example in the IDE, as shown below:

bleuart_cmdmede | Arduino 1.6.4 - - -‘@M

File Edit Sketch Tools Help

bleuart_cmdmode §

rEa! -
Gfile bleuart_cmdwode. ino
[fauthor hathach, ktown (Adafruit Industries)

This demo will show you how to send and receive data in COMMAND mode | &
(without needing to put the module into DATA mode or using the MODE pin)

*/

#include <string.hs

#include <Arduino.h>

#include <SPI.h>

#include <SoftwareSerial.h>

#include "Adafruit BLE.h"
#include "Adafruit BLE_HWSPI.h"
#include "Adafruit BluefruitLE_UART.h"

// If you are using Software Serial....
// The following macros declare the pins used for 5W serial, you should
// use these pins if you are connecting the TUART Friend to |an Qo]

#define ELUEFRUIT_SWUART FXD_FPIN 9 /4 Bequired for software serial!l
#define BLUEFRUIT_SWUART TXD_FPIN 10 // Bequired for software serial!
#define BLUEFRUIT_UART_CTS_PIN 11 // Bequired for software serial!
#define ELUEFRUIT_UART_RTS_PIN -1 /4 Optional, set to -1 if unused

// If you are using Hardware Serial
// The following macros declare the Serial port you are using. Uncomment this

P8 Vdamm §E smmna mmen damcr #lac DIT 4m Tomcmmcaede /W& cee ca T1oaeo

4 [ | +

Adafruit Flora on

Configuration

Check the Configuration! page earlier to set up the sketch for Software/Hardware UART or Software/Hardware SPI. The default is hardware SPI
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If using software or hardware Serial UART:
e This tutorial does not need to use the MODE pin,make sure you have the mode switch in CMD modeif you do not configure & connect a

MODE pin
e Don't forget to also connect the CTS pin on the Bluefruit to ground if you are not using it{(The Flora has this already done)

Running the Sketch

Once you upload the sketch to your board (via the arrow-shaped upload icon), and the upload process has finished, open up the Serial Monitor
via Tools > Serial Monitor, and make sure that the baud rate in the lower right-hand corner is set to115200:

COM250 (Adafruit Flora) =NACN X
RAdafruit Bluefruit Command Mode Example -

Initialising the Bluefruit LE module: ATZ

<- OK
OK!
Performing a factory reset: AT+FACTORYRESET

<- 0K
LTE=0

<- RTE=0
0K
Requesting Bluefruit info:

m

BLEFRIEND32
nRF51822 QFACRLO0
D5321FT75475B19EE
0.8.2

0.8.2

Zpr 30 2015

5110 &.0.0, 0.2
[v):4

Please use Adafruit Bluefruit LE app to connect in UART mode
Then Enter characters to send to Bluefruit

Autoscroll :No line ending :9600 baud -

Once you see the request, use the App to connect to the Bluefruit LE module ilJART mode so you get the text box on your phone

Any text that you type in the box at the top of the Serial Monitor will be sent to the connected phone, and any data sent from the phone will be
displayed in the serial monitor:
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COM250 (Adafruit Flora) [E=SREERr
|

<- OK
OK!
Performing a factory reset: AT+FACTORYRESET

<- 0K
LTE=0

<- RTE=0

0K

Requesting Bluefruit info:
BLEFRIEND32
nRF51822 QFACRIO0
D5321F75475B19EE
0.6.2

0.6.2

Apr 30 2015

5110 &.0.0, 0.2
0K

m

Please use Adafruit Bluefruit LE app to connect in UART mode
Then Enter characters to send to Bluefruit

ko kkk

[Send] Hello, Adafruit!

Autoscroll

:Nohneenmng v: ﬁﬁoobaud

You can see the incoming string here in the Adafruit Bluefruit LE Connect app below (iOS in this case):
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Hello, Adafruit!

Why hello, Arduino! Send

space

The response text ('Why hello, Arduino!’) can be seen below:
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[(send ]

<- 0K
OK!

<- 0K
LTE=0

<- RTE=0

0K

Requesting Bluefruit info:
| |BLEFRIEND32
nRF51822 QFACRIO0
D5321F75475B19EE
0.6.2

0.6.2

Apr 30 2015

5110 &.0.0, 0.2
0K

ko kkk

[Send] Hello, Adafruit!
[Recwv] Why helleo, Arduinc!

Performing a factory reset: AT+FACTORYRESET

||Flease use Adafruit Bluefruit LE app to connect in URRT mode
Then Enter characters to send to Bluefruit

-

m

(] Autoscroll
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HIDKeyboard

The HIDKeyboard example shows you how you can use the built-in HID keyboard AT commands to send keyboard data to any BLE-enabled
Android or iOS phone, or other device that supports BLE HID peripherals.

Opening the Sketch

To open the ATCommand sketch, click on the File > Examples > Adafruit_BluefruitLE_nRF51 folder in the Arduino IDE and select
hidkeyboard:

Adafruit_AHRS [ 2
Adafruit_BluefruitLE_nRF51 > atcommand
Adafruit_BMP085_Unified > beacon
Adafruit_BMP183_Unified_Library »> bleuart
Adafruit_BNOO055 > factoryreset
Adafruit_CC3100 2 heartratemonitor
Adafruit_DHT_Unified > hidkeyboard
Adafruit_DotStar > uribeacon
Adafruit_FONA_Library >

This will open up a new instance of the example in the IDE, as shown below:

hidkeyboard

vold setup(void) <

Serial.begin{l15200);
Serial.y In(F("BLE HID FEYBOAFD EXAMPLE")):
Serial.println(F("------—---—mmmmm oo "1

/* Inictialise the module */
Serial.print(F{"Initialising the Bluefruit LE module: "});

if { !ble.begin() )

{

(1 Serial.printin( F("FAILED! (Check your wiring?)"™) ):
while(l) ()}

¥

Serial.printin{ F{"0K!"}) };

f* Perform a factory reset to make sure everything is in a known state %/
Serial.print(F{"Pecforming a factory reset: ")):
EXECUTE( ble.factoryReset() ):

(| /* Disable command echo from Bluefruit */
ble.echo(falze);

/* Set ble command verbose */

A* Print Bluefruit information */
ble.info():

Configuration

Check the Configuration! page earlier to set up the sketch for Software/Hardware UART or Software/Hardware SPI. The default is hardware SPI

If using software or hardware Serial UART:
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e This tutorial does not need to use the MODE pin,make sure you have the mode switch in CMD mode!
e Don't forget to also connect the CTS pin on the Bluefruit to ground if you are not using it{(The Flora has this already done)

Running the Sketch

Once you upload the sketch to your board (via the arrow-shaped upload icon), and the upload process has finished, open up the Serial Monitor
via Tools > Serial Monitor, and make sure that the baud rate in the lower right-hand corner is set to115200:

- — .
COM250 (Adafruit Flora) [E=SREER
|

RAdafruit Bluefruit HID Keyboard Example Il i

Initialising the Bluefruit LE module: I
ATZ

<- OK

OK!

Performing a factory reset:
AT+FACTORYRESET

<- 0K
LTE=0

<- RTE=0

0K

Requesting Bluefruit info:
BLEFRIEND32
nRF51822 QFACRIO0
D5321F75475B198E
0.6.2

0.6.2

Apr 30 2015

5110 &.0.0, 0.2
0K

m

Setting device name to "Bluefruit EKeyboard':
AT+GAPDEVNAME=Blusefruit Keyboard

<- OK
Enable Keyboard Service:
AT+BleKeyboardEn=0n

<- OK
Performing & SW reset (service changes reguire a reset):
ATZ

<- 0K

Go to your phone's Bluetocoth settings to pair your device
then open an application that accepts keyboard input

Enter the character(s) to send:
- \r for Enter

- \n for newline

- \t for tab

- \b for backspace

keyboard > -

:No line ending v: :115200 baud v:

Autoscroll

To send keyboard data, type anything into the textbox at the top of the Serial Monitor and click theSend button.

Bonding the HID Keyboard

Before you can use the HID keyboard, you will need to 'bond' it to your phone or PC. The bonding process establishes a permanent connection
between the two devices, meaning that as soon as your phone or PC sees the Bluefruit LE module again it will automatically connect.

The exact procedures for bonding the keyboard will varying from one platform to another.

When you no longer need a bond, or wish to bond the Bluefruit LE module to another device, be sure to delete the bonding information on the
phone or PC, otherwise you may not be able to connect on a new device!
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Android

To bond the keyboard on a Bluetooth Low Energy enabled Android device, go to theSettings application and click the Bluetooth icon.

These screenshots are based on Android 5.0 running on a Nexus 7 2013. The exact appearance may vary depending on your device and OS
version.

Wireless & networks

¥ WiFi 3 Bluetooth

(Q Datausage e« More

Inside the Bluetooth setting panel you should see the Bluefruit LE module advertising itself asBluefruit Keyboard under the 'Available devices'
list:

< Bluetooth

On

Available devices G

3 69:0C:12:C6:2A:75
EE  Bluefruit Keyboard
% 14:99:E2:05:29:CF

Nexus 7 is visible to nearby devices while Bluetooth Settings is open.

Tapping the device will start the bonding process, which should end with the Bluefruit Keyboard device being moved to a new 'Paired devices' list
with 'Connected' written underneath the device name:

Paired devices

Bluefruit Keyboard Q

Connected

To delete the bonding information, click the gear icon to the right of the device name and the click thé&Forget button:
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Paired devices
Name

Bluefruit Keyboard

Use for

Input device

FORGET oK

To bond the keyboard on an iOS device, go to the Settings application on your phone, and click the Bluetooth menu item.

The keyboard should appear under the OTHER DEVICES list:
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®0e00 Free & 15:27 70} mm

< Settings Bluetooth

Bluetooth dfi )

Now discoverable as “iPhone de Kevin”.

MY DEVICES

SONY:CMT-X5CD Not Connected (i)

OTHER DEVICES -,
Adafruit Bluefruit LE

To pair an Apple Watch with your iPhone, go to the Apple
Watch app.

Once the bonding process is complete the device will be moved to theMY DEVICES category, and you can start to use the Bluefruit LE module as
a keyboard:

MY DEVICES
Bluefruit Keyboard Connected (i)
SONY:CMT-X5CD Not Connected @

To unbond the device, click the 'info' icon and then select theForget this Device option in the menu:

< Bluetooth Bluefruit Keyboard

Forget This Device

OS X

To bond the keyboard on an OS X device, go to the Bluetooth Preferences window and click the Pair button beside the Bluefruit Keyboard
device generated by this example sketch:
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sen = —

Devices Ead
e Bluefruit Keyboard Pair
Bluetooth: On
Turn Bluetooth Off
Now discoverable as
“Kevin's MacBook Pro”
¥ Show Bluetooth in menu bar Advanced... ?

To unbond the device once it has been paired, click the small 'x' icon besideBluefruit Keyboard:

een | Bletoot

Devices i.-‘

Bluefruit Keyboard o)

Connected

Bluetooth: On
Turn Bluetooth Off
Now discoverable as
“Kevin's MacBook Pro”
¥ Show Bluetooth in menu bar Advanced... ?

... and then click the Remove button when the confirmation dialogue box pops up:

Are you sure you want to remove “Bluefruit Keyboard”?
You have to pair this device a.gain if you want to use it later.

Cancel Remove
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Controller

The Controller sketch allows you to turn your BLE-enabled iOS or Android device in a hand-held controller or an external data source, taking
advantage of the wealth of sensors on your phone or tablet.

You can take accelerometer or quaternion data from your phone, and push it out to your Arduino via BLE, or get the latest GPS co-ordinates for
your device without having to purchase (or power!) any external HW.

Opening the Sketch

To open the Controller sketch, click on the File > Examples > Adafruit_BluefruitLE_nRF51 folder in the Arduino IDE and selectcontroller:

Adafruit AHRS

Adafruit_BluefruitLE_nRF51 atcommand
Adafruit_ BMP085_Unified beacon
Adafruit_ BMP183_Unified_Library bleuart_cmdmode

Adafruit CC3100
Adafruit_DHT_Unified
Adafruit_DotStar

Adafruit. FONA_Library
Adafruit_HMC5883_Unified
Adafruit_L3GD20_U
Adafruit_LSM303DLHC

bleuart_datamode
controller
factoryreset
heartratemonitor
hidkeyboard
uribeacon

VVYVYVYYVYVYY VYAl

This will open up a new instance of the example in the IDE, as shown below:

controller | Arduino 1.6.4

winclude <string.h=
#include <Arduino. b
#include <5P1.h>

8 #include <Sof

#include ”
#include "A
+ #include

clare the pins used fo
nY if i Q connecting the L

#define BLUEFRULT_SWUART_RXD_PIN

@ #define BLUEFRUIT_SWUART_TXD_PIN
#define BLUEFRUTT_UART_CTS_PIN
#define BLUEFRUIT_UART_RTS_PIN

#define BLUEFRUTT _HWSERTAL MAME

Other recommended pins!

2 #define BLUEFRUIT_UMRT_MOOE_PIM 12 Optional but recommended, set to -1 if wused

Configuration

Check the Configuration! page earlier to set up the sketch for Software/Hardware UART or Software/Hardware SPI. The default is hardware SPI
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If using software or hardware Serial UART:

e This tutorial will also be easier to use if you wire up the MODE pin, you can use any pin but our tutorial has pin 12 by default. You can change
this to any pin. If you do not set the MODE pin then make sure you have the mode switch in CMDmode
e If you are using a Flora or otherwise don't want to wire up the Mode pin, set the BLUEFRUIT_UART_MODE_PIN to -1 in the configuration
tab so that the sketch will use the +++ method to switch between Command and Data mode!
e Don't forget to also connect the CTS pin on the Bluefruit to ground if you are not using it{(The Flora has this already done)

Running the Sketch

Once you upload the sketch to your board (via the arrow-shaped upload icon), and the upload process has finished, open up the Serial Monitor
via Tools > Serial Monitor, and make sure that the baud rate in the lower right-hand corner is set to115200:

0@

13

0K !

/devicu.usbmodem1411131

Send

Performing o factory reset: AT+FACTORYRESET

<~ AT+FACTORYRESET
0K
ATE=8

<- ATE=B

0K

Requesting Bluefruit info:
BLEFRIEND3Z
nRF51822 QFACAL®
B789692ZAERBCI491
0.6.2

0.6.2

Apr 38 2015
5110 8.9.0, 0.2
0K

Please use Adafruit Bluefruit LE app to connect in Controller mode
Then activate/use the sensors, color picker, game controller, etc!

Ig Autoscroll

No line ending 115200 baud +

Using Bluefruit LE Connect in Controller Mode

Once the sketch is running you can open Adafruit's Bluefruit LE Connect application (available forAndroid (http://adafru.it/f4G) or
iOS (http://adafru.it/f4H)) and use the Controller application to interact with the sketch. (If you're new to Bluefruit LE Connect, have a look at our
dedicated Bluefruit LE Connect learning guide (http://adafru.it/iCm).)

On the welcome screen, select the Adafruit Bluefruit LE device from the list of BLE devices in range:

all Adafruit Bluefruit LE

-43

UART capable

Connect

Then from the activity list select Controller:
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file:///bluefruit-le-connect-for-ios/settings

Connect to Adafruit Bluefruit LE
Choose mode:

Info

UART

Pin I/O

Controller

Cancel

This will bring up a list of data points you can send from your phone or tablet to your Bluefruit LE module, by enabling or disabling the appropriate
sSensor(s).

Streaming Sensor Data

You can take Quaternion (absolute orientation), Accelerometer, Gyroscope, Magnetometer or GPS Location data from your phone and send it
directly to your Arduino from the Controller activity.

By enabling the Accelerometer field, for example, you should see accelerometer data update in the app:

Quaternion OFF
Accelerometer
x: 0.15683
y: -0.580338
z: -0.794373
Gyro OFF
Magnetometer OFF
Location

The data is parsed in the example sketch and output to the Serial Monitor as follows:

Accel 0.20 -0.51 -0.76
Accel 0.22 -0.50 -0.83
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Accel 0.25 -0.51 -0.83
Accel 0.21 -0.47 -0.76
Accel 0.27 -0.48 -0.82

[ [ /devicu.usbmodem1411131
| Send
Accel @.16 @8.55 -@.82
Accel @.14 8.53 -8.81
Accel @.17 .52 -0.83
Accel 9.14 0.52 -8.83
Accel @.18 @8.55 -0.78
Accel @.18 @.38 -0.98
Accel @.13 8.37 -1.8
Accel @.16 8.37 -8.92
Accel @.24 .43 9.83
Accel @.20 -8.33 -1.83
Accel @.20 -0.41 -0.93
Accel @.17 8.44 -0.79
Accel @.23 8.51 -@.84
Accel @.20 .48 -8.86
Accel 8.21 0.48 -8.82
Accel @.20 8.50 -@.81
Accel @.21 @8.51 -0.87
Accel @.22 8.43 -0.84
Accel @.20 8.51 -8.76
Accel @.22 .50 9.83
Accel @.25 -8.51 -8.83
Accel @.21 -0.47 -0.76
Accel @.27 -0.48 -8.82
™ Autoscroll No line ending  + 115200 baud +

Note that even though we only print 2 decimal points, the values are received from the App as a full 4-byte floating point.

Control Pad Module

You can also use the Control Pad Module to capture button presses and releases by selecting the appropriate menu item:

Control Pad

This will bring up the Control Pad panel, shown below:

Button presses and releases will all be logged to the Serial Monitor with the ID of the button used:

Button 8 pressed
Button 8 released
Button 3 pressed
Button 3 released
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Color Picker Module

You can also send RGB color data via the Color Picker module, which presents the following color selection dialogue:

22:38

Color Picker

R:164 G:47 B:255

This will give you Hexadecimal color data in the following format:
RGB #A42FFF

You can combine the color picker and controller sample sketches to make color-configurable animations triggered by buttons in the mobile app--
very handy for wearables! Download this combined sample code (configured for Feather but easy to adapt to FLORA, BLE Micro, etc.) to get
started:
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feather_bluefruit_neopixel_animation_controller.zip
http://adafru.it/kzF
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HeartRateMonitor

The HeartRateMonitor example allows you to define a new GATT Service and associated GATT Characteristics, and update the characteristic
values using standard AT commands.

Opening the Sketch

To open the ATCommand sketch, click on the File > Examples > Adafruit_BluefruitLE_nRF51 folder in the Arduino IDE and select
heartratemonitor:

Adafruit_AHRS [ 2
Adafruit_BluefruitLE_nRF51 > atcommand
Adafruit_BMP085_Unified > beacon
Adafruit_BMP183_Unified_Library »> bleuart
Adafruit_BNOO055 > factoryreset
Adafruit_CC3100 2 heartratemonitor
Adafruit_DHT_Unified > hidkeyboard
Adafruit_DotStar > uribeacon

Adafruit_FONA_Library

This will open up a new instance of the example in the IDE, as shown below:

v

(22l heartratemonitor | Ard

File Edit Sketch Tools Help

hearraternonitar

* -

vold setup (void)

{
Serial.begin(115200) ;
Serial.println(F({"ELE HEART FATE MONITOFR. (HEM) EXAMPLE")):
Serial.println(F(" "

randomSeedinicros());

/* Initialise the module */
Serial.print(F{"Initializsing the Blusfruit LE module: "));

if { 'ble.begin() )

{
Serial.println( F{"FAILED! (Check your wiring?)") ):
whilei{l){}

}

Serial.printlng F("0E!"™) }:

/* Perform a factory reset to make sure everything is in a known state */
Serial.print(F("Performning a factory reset: "));
EXECUTE( ble.factoryReset() ):

/* Disable command echo from Bluefruit */
ble.echo(false);

/* Set ble command verbose */
ble.verbose (VEREOSE_MODE) ; -

4 | i b

Configuration
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Check the Configuration! page earlier to set up the sketch for Software/Hardware UART or Software/Hardware SPI. The default is hardware SPI

If Using Hardware or Software UART

This tutorial does not need to use the MODE pin,make sure you have the mode switch in CMD modeif you do not configure & connect a
MODE pin

This demo uses some long data transfer strings, so we recommend defining and connecting both CTS and RTS to pins, even if you are using
hardware serial.

If you are using a Flora or just dont want to connect CTS or RTS, set the pin #define's to -1 an®on't forget to also connect the CTS pin on the
Bluefruit to ground! (The Flora has this already done)

If you are using RTS and CTS, you can remove this line below, which will slow down the data transmission
// this line is particularly required for Flora, but is a good idea

/I anyways for the super long lines ahead!
ble.setinterCharWriteDelay(5); // 5 ms

Running the Sketch

Once you upload the sketch to your board (via the arrow-shaped upload icon), and the upload process has finished, open up the Serial Monitor
via Tools > Serial Monitor, and make sure that the baud rate in the lower right-hand corner is set to115200:

COM250 (Adafruit Flora) [ESRIERX

(Rdafruit Bluefruit Heart Rate Monitor (HEM) Example -

Initialising the Bluefruit LE module:
ATZ

m

- OK
jOK !

Performing a factory reset:
AT+FACTORYRESET

- OK
LTE=0

- RTE=0
[OK
Requesting Bluefruit info:

[[ELEFRIEND32

NRF51822 QFACRLO0

D5321F75475B198E

0.6.2

0.6.2

Apr 30 2015

W|s110 &.0.0, 0.2

[OK

Setting device name to "Bluefruit HEM':
IAT+GAFDEVNAME=Bluefruit HEM

q |~ [T G

:No line ending v: :9600 baud v:
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,@ 'COMZ50 (Adafruit Fiora) T A — =

Setting device name to 'Bluefruit HRM':
AT+GAPDEVNAME=Bluefruit HRM

<- OK
Adding the Heart Rate Service definitien (UUID = 0x180D):
AT+GATTADDSERVICE=UUID=0x180D

1

<= 1

<~ oK

2Adding the Heart Rate Measurement characteristic (UUID = 0x2A37):
AT+GATTADDCHAR=UUID=0x2A37, PROPERTIES=0x10, MIN_LEN=2, MAX LEN=3, VALUE=00-40
<= 1

<= OK

Bdding the Body Sensor Location characteristic (UUID = Ox2RA38):
AT+GATTADDCHAR=UUID=0x2R38, PROFERTIES=0x02, MIN_LEN=1, VALUE=3

<= 2

<= OH
Il' hdding Heart Rate Service TUID to the adwvertising payload: AT+GAPSETADVDATA=0Z-01=-06-05-02=-0d-18-0a=-18

<= O
Performing a 5W reset (service changes require a reset): ATZ

<= QK

Updating HEM value to 82 BEM
AT+GATTCHAR=1,00-52

[<- ox
[|Updating HEM value to &1 BEM
AT+GATICHAR=1,00-3D

[ toscrol Nokneendng | (s600baud v

If you open up an application on your mobile device or laptop that support the standardHeart Rate Monitor Service (http://adafru.it/f4l), you should

be able to see the heart rate being updated in sync with the changes seen in the Serial Monitor:

nRF Toolbox HRM Example

The image below is a screenshot from the free nRE Toolbox (http://adafru.it/e9M) application from Nordic on Android (also available on

iOS (http://adafru.it/f4J)), showing the incoming Heart Rate Monitor data:
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* " H 03:12

Jel' BLUEFRUIT HRM

Finger 55

sensor position bpm

80

| /\\ \\
AV

L

BPM
(=]

2 4 6 8 10
Time (seconds)

—=— Heart Rate

DISCONNECT

Wireless by Nordic

CoreBluetooth HRM Example

The image below is from a freely available CoreBluetooth sample application (http://adafru.it/f4K) from Apple showing how to work with Bluetooth
Low Energy services and characteristics:
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@ L Heart Rate Monitor

Connected
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UriBeacon

The UriBeacon example shows you how to use the built-in UriBeacon AT commands to configure the Bluefruit LE module as a UriBeacon
advertiser, following Google's Physical Web UriBeacon (http:/adafru.it/edk) specification.

Opening the Sketch

To open the ATCommand sketch, click on the File > Examples > Adafruit_BluefruitLE_nRF51 folder in the Arduino IDE and selecturibeacon:

Adafruit_ AHRS >

Adafruit_BluefruitLE_nRF51 > atcommand
Adafruit_BMP085_Unified > beacon
Adafruit_BMP183_Unified_Library > bleuart
Adafruit_BNOO055 > factoryreset
Adafruit_CC3100 2 heartratemonitor
Adafruit_DHT_Unified > hidkeyboard
Adafruit_DotStar > uribeacon

Adafruit_FONA_Library

v

This will open up a new instance of the example in the IDE, as shown below. You can edit the URL that the beacon will point to, from the default
http://www.adafruit.com or just upload as is to test

@ uribeacon | Arduinc 16.4 [ -]
File Edit Sketch Tools Help
00 BEHR

uribeacon

#define BLUEFRUIT_UART_TXD_PIN i)
#define BLUEFRUIT UART_CTS_PIN (10
#define ELUEFRUIT UART RTS_PIN {11)

//hdafruit_BLE_HVWSPI ble(BLUEFRUIT_SPI_C5_PIN, BLUEFRUIT_SPI_IRQ_PIN /*, BLUEFRUIT_SPI_RST PIN *,
Adafruit_BLE_SWUART ble(BLUEFRUIT_UART RXD_PIN, BLUEFRUIT UART TXD_PIN,
BLUEFRUIT_UART CTS_PIN, ELUEFRUIT UART RTS_PIN, BLUEFRUIT_UART_MODE_PIN);

£
/ ==== ====

#define BUFSIZE 128

// URL that is advertised, it must not longer than 17 (omitted http:// and wv.)
#define URL “htop: //www. adafruit. con”

m

Jnt
Bbrief Helper MACROS to check command execution. Print 'FAILED!' or "OK'',
loop forewver if failed
*

#define EXECUTE (command)
do{ I
if ( '(command) ) { Serial.println( F{"FAILED!™) };: while(l){} }\

Serial.println( F("0E!'™) ):
Jwhile(0) H

Arduine Uno on ©

Configuration

Check the Configuration! page earlier to set up the sketch for Software/Hardware UART or Software/Hardware SPI. The default is hardware SPI

If using software or hardware Serial UART:
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e This tutorial does not need to use the MODE pin,make sure you have the mode switch in CMD modeif you do not configure & connect a

MODE pin

e Don't forget to also connect the CTS pin on the Bluefruit to ground if you are not using it{(The Flora has this already done)

Running the Sketch

Once you upload the sketch to your board (via the arrow-shaped upload icon), and the upload process has finished, open up the Serial Monitor

via Tools > Serial Monitor, and make sure that the baud rate in the lower right-hand corner is set to115200:

COM250 (Adafruit Flora

Adafruit Bluefruit UriBeacon Example

Initialising the Bluefruit LE module:
ATZ

<- OK

OK!

Performing a factory reset:
AT+FACTORYRESET

<- 0K
LTE=0

<- RTE=0

0K

Requesting Bluefruit info:
BLEFRIEND32
nRF51822 QFACRIO0
D5321F75475B198E
0.6.2

0.6.2

Apr 30 2015

5110 &.0.0, 0.2
0K

Setting uri beacon to Adafruit website: AT+BLEURIBEACON=http://www.adafruit.com

<- 0K

Please use Google Physical Web application to test

Autoscroll :No line ending v: :115200 baud v:

%

At this point you can open the Physical Web Application for Android (http://adafru.it/edi) or for iOS (http://adafru.it/edj), and you should see a link

advertising Adafruit's website:

% o H 16140

Nearby Beacons

Adafruit Industries, Unique & fun DIY electronics and kits
http://www.adafruit.com

Adafruit Industries, Unique & fun DIY electronics and kits : - Tools Gift Certificates Arduino

Cables Sensors LEDs Books Power EL Wire/Tape/Panel Components & Parts LCDs &...

© Adafruit Industries https://learn.adafruit.com/adafruit-feather-32u4-bluefruit-le

Page 64 of 133


https://play.google.com/store/apps/details?id=physical_web.org.physicalweb
https://itunes.apple.com/us/app/physical-web/id927653608?mt=8

HALP!

When using the Bluefruit Micro or a Bluefruit LE with Flora/Due/Leonardo/Micro the examples dont run?

We add a special line to setup() to make it so the Arduino will halt until it sees you've connected over the Serial console. This makes debugging
great but makes it so you cannot run the program disconnected from a computer.

Solution? Once you are done debugging, remove these two lines from setup()

while (ISerial);
delay(500);

| can't seem to "Find" the Bluefruit LE!

Getting something like this?

COMZ50 (Adafruit Flora)

Adafruit Bluefruit AT Command Example

ATZ

<- RATZ

<- RATZ

<- RATZ

<- RATZ

Initialising the Bluefruit LE module:

<— Couldn't find Bluefruit, make sure it's in CoMmanD mode & check wiring?

Autoscroll

For UART/Serial Bluefruits:
L]
L]
L]
L]
L]
L]

If using SPI Bluefruit:

:No line ending v: :9600 baud v:

Check you have the MODE switch in CMD and the MODE pin not wired to anything if it isnt used!

If you are trying to control the MODE from your micro, make sure you set the MODE pin in the sketch
Make sure you have RXI and TXO wired right! They are often swapped by accident

Make sure CTS is tied to GND if you are using hardware serial and not using CTS

Check the MODE red LED, is it blinking? If its blinking continuously, you might be in DFU mode, power cycle the module!
If you are using Hardware Serial/Software Serial make sure you know which one and have that set up

e Make sure you have all 5 (or 6) wires connected properly.
e If using hardware SPI, you need to make sure you're connected to the hardware SPI port, which differs depending on the main chipset.

If using Bluefruit Micro:

e Make sure you change the RESET pin to #4 in any Config file. Also be sure you are using hardware SPI to connect!
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AT Commands

The Bluefruit LE modules use a Hayes AT-style command set (http://adafru.it/ebd)to configure the device.

The advantage of an AT style command set is that it's easy to use in machine to machine communication, while still being somewhat user friendly
for humans.

Test Command Mode '=?'

"Test' mode is used to check whether or not the specified command exists on the system or not.

Certain firmware versions or configurations may or may not include a specific command, and you can determine if the command is present by
taking the command name and appending '=?" to it, as shown below

AT+BLESTARTADV=?

If the command is present, the device will reply with'OK'. If the command is not present, the device will reply with' ERROR'.
AT+BLESTARTADV=?

OK\r\n

AT+MISSINGCMD="?
ERROR\r\n

Write Command Mode '=xxx'

'Write' mode is used to assign specific value(s) to the command, such as changing the radio's transmit power level using the command we used
above.

To write a value to the command, simple append an'=" sign to the command followed by any paramater(s) you wish to write (other than a lone'?"
character which will be interpretted as tet mode):

AT+BLEPOWERLEVEL=-8
If the write was successful, you will generally get an'OK' response on a new line, as shown below:

AT+BLEPOWERLEVEL=-8
OK\r\n

If there was a problem with the command (such as an invalid parameter) you will get aHERROR' response on a new line, as shown below:

AT+BLEPOWERLEVEL=3
ERROR\r\n

Note: This particular error was generated because '3' is not a valid value for the AT+BLEPOWERLEVEL command. Entering -4', '0" or '4wvould
succeed since these are all valid values for this command.

Execute Mode

'Execute’ mode will cause the specific command to 'run’, if possible, and will be used when the command name is entered with no additional
parameters.

AT+FACTORYRESET
You might use execute mode to perform a factory reset, for example, by executing the AT+FACTORYRESET command as follows:

AT+FACTORYRESET
OK\r\n

NOTE: Many commands that are means to be read will perform the same action whether they are sent to the command parser in 'execute' or
'read' mode. For example, the following commands will produce identical results:

AT+BLEGETPOWERLEVEL
-4\r\n

OK\r\n
AT+BLEGETPOWERLEVEL?
-4\r\n

OK\r\n

If the command doesn't support execute mode, the response will normally b ERROR' on a new line.
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Read Command Mode '?’

'Read' mode is used to read the current value of a command.

Not every command supports read mode, but you generally use this to retrieve information like the current transmit power level for the radio by
appending a '?' to the command, as shown below:

AT+BLEPOWERLEVEL?

If the command doesn't support read mode or if there was a problem with the request, you will normally get alERROR' response.
If the command read was successful, you will normally get the read results followed byOK' on a new line, as shown below:
AT+BLEPOWERLEVEL?

-4\r\n

OK\r\n

Note: For simple commands, 'Read' mode and 'Execute’ mode behave identically.
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Standard AT

The following standard Hayes/AT commands are available on Bluefruit LE modules:

AT

Acts as a ping to check if we are in command mode. If we are in command mode, we should receive the 'OK' response.

Codebase Revision: 0.3.0
Parameters: None

Output: None

AT
OK

ATI

Displays basic information about the Bluefruit module.
Codebase Revision: 0.3.0

Parameters: None

Output: Displays the following values:

e Board Name

e Microcontroller/Radio SoC Name

e Unique Serial Number

e Core Bluefruit Codebase Revision

e Project Firmware Revision

e Firmware Build Date

o Softdevice, Softdevice Version, Bootloader Version (0.5.0+)

ATI

BLEFRIEND
nRF51822 QFAAG00
FB462DF92A2C8656
0.5.0

0.5.0

Feb 24 2015
$1107.1.0, 0.0

OK

Updates:

o Version 0.4.7+ of the firmware adds the chip revision after the chip name if it can be detected (ex. 'nRF51822 QFAAGO00').
o Version 0.5.0+ of the firmware adds a new 7th record containing the softdevice, softdevice version and bootloader version (ex. 'S110 7.1.0,

0.0).

ATZ

Performs a system reset.
Codebase Revision: 0.3.0
Parameters: None

Output: None

ATZ
OK

ATE
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Enables or disables echo of input characters with the AT parser
Codebase Revision: 0.3.0

Parameters: '1' = enable echo, '0' = disable echo

Output: None

# Disable echo support
ATE=0

OK

#Enable echo support
ATE=1

OK

+++

Dynamically switches between DATA and COMMAND mode without changing the physical CMD/UART select switch.

When you are in COMMAND mode, entering '+++\n' or "+++\r\n' will cause the module to switch to DATA mode, and anything typed into the
console will go direct to the BLUE UART service.

To switch from DATA mode back to COMMAND mode, simply enter '+++\n' or '+++\r\n' again (be sure to include the new line character!), and a
new 'OK' response will be displayed letting you know that you are back in COMMAND mode (see the two 'OK' entries in the sample code below).

Codebase Revision: 0.4.7
Parameters: None
Output: None

Note that +++ can also be used on the mobile device to send and receive AT command on iOS or Android, though this should always be used with
care.
See the AT+MODESWITCHEN command to control the availability of the +++ command

ATI

BLEFRIEND
nRF51822 QFAAG00
B122AAC33F3D2296
0.4.6

0.4.6

Dec 22 2014

OK

+++

OK

OK
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General Purpose

The following general purpose commands are available on all Bluefruit LE modules:

AT+FACTORYRESET

Clears any user config data from non-volatile memory and performs a factory reset before resetting the Bluefruit module.
Codebase Revision: 0.3.0

Parameters: None

Output: None

AT+FACTORYRESET
OK

As of version 0.5.0+ of the firmware, you can perform a factory reset by holding the DFU button down for 10s until the blue CONNECTED LED
lights up, and then releasing the button.

AT+DFU

Forces the module into DFU mode, allowing over the air firmware updates using a dedicated DFU app on iOS or Android.
Codebase Revision: 0.3.0

Parameters: None

Output: None

The AT parser will no longer responsd after the AT+DFU command is entered, since normal program execution effectively halts and a full system
reset is performed to start the bootloader code

AT+DFU
OK

AT+HELP

Displays a comma-separated list of all AT parser commands available on the system.
Codebase Version: 0.3.0

Parameters: None

Output: A comma-separated list of all AT parser commands available on the system.

The sample code below may not match future firmware releases and is provided for illustration purposes only

AT+HELP
AT+FACTORYRESET,AT+DFU,ATZ ATI,ATE, AT+DBGMEMRD,AT+DBGNVMRD,AT+HWLEDPOLARITY, AT+HWLED,AT+HWGETDIETEMP ,AT+HWMODEPINPOLARITY AT +HV
OK

AT+NVMWRITE

Writes data to the 256 byte user non-volatile memory (NVM) region.
Codebase Version: 0.7.0
Parameters:

« offset: The numeric offset for the first byte from the starting position in the user NVM
o datatype: Which can be one of STRING (1), BYTEARRAY (2) or INTEGER (3)
o data: The data to write to NVM memory (the exact payload format will change based on the specified datatype).

Output: Nothing

# Write 32768 as an integer starting at byte 16 in user NVM

© Adafruit Industries https://learn.adafruit.com/adafruit-feather-32u4-bluefruit-le Page 70 of 133



AT+NVMWRITE=16,INTEGER,32768
OK

AT+NVMREAD

Reads data from the 256 byte user non-volatile memory (NVM) region.
Codebase Version: 0.7.0
Parameters:

« offset: The numeric offset for the first byte from the starting position in the user NVM

e size: The number of bytes to read

o datatype: The type used for the data being read, which is required to properly parse the data and display it as a response. The value can be
one of STRING (1), BYTEARRAY (2) or INTEGER (3)

Output: The data read back, formatted based on the datatype argument.
# Read an integer back from position 16 in user NVM
AT+NVMREAD=16, 4, INTEGER

32768
OK

AT+MODESWITCHEN

Enables or disables mode switches via the '+++' command on the BLE peripheral of BLE UART side of the connection.
Codebase Version: 0.7.1
Parameters:

e location: This can be a string, either local' or ble' indicating which side should have the '+++' command enabled or disabled, 'local' being
the Bluefruit peripheral and 'ble' being the phone or tablet.
o state: '0' to disable '+++' mode switches, 1' to enable them.

Output: None

By default, '+++' is enabled locally, and disabled in BLE
# Disable reomte "+++' mode switches

AT+MODESWITCHEN=ble,0
OK
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Hardware

The following commands allow you to interact with the low level HW on the Bluefruit LE module, such as reading or toggling the GPIO pins,
performing an ADC conversion ,etc.:

AT+BAUDRATE

Changes the baud rate used by the HW UART peripheral on the nRF51822.
Codebase Revision: 0.7.0
Parameters: Baud rate, which must be one of the following values:

1200
2400
4800
9600
14400
19200
28800
38400
57600
76800
115200
230400
250000
460800
921600
1000000

e O o o o o o o o o o o o o o o

Output: The current baud rate
# Set the baud rate to 115200
AT+BAUDRATE=115200

OK

# Check the current baud rate
AT+BAUDRATE

115200
OK

AT+HWADC

Performs an ADC conversion on the specified ADC pin
Codebase Revision: 0.3.0
Parameters: The ADC channel (0..7)

Output: The results of the ADC conversion

AT+HWADC=0
178
OK

AT+HWGETDIETEMP

Gets the temperature in degree celcius of the BLE module's die. This can be used for debug purposes (higher die temperature generally means
higher current consumption), but does not corresponds to ambient temperature and can nto be used as a replacement for a normal temperature
sensor.

Codebase Revision: 0.3.0
Parameters: None

Output: The die temperature in degrees celcius
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AT+HWGETDIETEMP
32.25
OK

AT+HWGPIO

Gets or sets the value of the specified GPIO pin (depending on the pin's mode).

Codebase Revision: 0.3.0

Parameters: The parameters for this command change depending on the pin mode.

OUTPUT MODE: The following comma-separated parameters can be used when updating a pin that is set as an output:

e Pin numbers

e Pin state, where:
o 0 = clear the pin (logic low/GND)
o 1 = set the pin (logic high/VCC)

INPUT MODE: To read the current state of an input pin or a pin that has been configured as an output, enter the pin number as a single
parameter.

Output: The pin state if you are reading an input or checking the state of an input pin (meaning only 1 parameter is supplied, the pin number),
where:

e 0 means the pin is logic low/GND
e 1 means the pin is logic high/VCC

Trying to set the value of a pin that has not been configured as an output will produce an 'ERROR' response.
Some pins are reserved for specific functions on Bluefruit modules and can not be used as GPIO. If you try to make use of a reserved pin number
an 'ERROR' response will be generated.

# Set pin 14 HIGH
AT+HWGPIO=14,1
OK

# Set pin 14 LOW
AT+HWGPIO=14,0
OK

# Read the current state of pin 14
AT+HWGPIO=14

0

OK

# Try to update a pin that is not set as an output
AT+HWGPIOMODE=14,0

OK

AT+HWGPIO=14,1

ERROR

AT+HWGPIOMODE

This will set the mode for the specified GPIO pin (input, output, etc.).
Codebase Revision: 0.3.0
Parameters: This command one or two values (comma-separated in the case of two parameters being used):

e The pin number
e The new GPIO mode, where:
o 0= Input
o 1 = Output
o 2 = Input with pullup enabled
o 3 = Input with pulldown enabled

Output: If a single parameters is passed (the GPIO pin number) the current pin mode will be returned.

Some pins are reserved for specific functions on Bluefruit modules and can not be used as GPIO. If you try to make use of a reserved pin number
an 'ERROR' response will be generated.

# Configure pin 14 as an output
AT+HWGPIOMODE=14,0
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OK

# Get the current mode for pin 14
AT+HWPGIOMODE=14

0

OK

AT+HWI2CSCAN

Scans the 12C bus to try to detect any connected 12C devices, and returns the address of devices that were found during the scan process.

Codebase Revision: 0.3.0

Parameters: None

Output: A comma-separated list of any 12C address that were found while scanning the valid address range on the 12C bus, or nothing is no

devices were found.

# 12C scan with two devices detected
AT+HWI2CSCAN

0x23,0x35

OK

# 12C scan with no devices detected

AT+HWI2CSCAN
OK

AT+HWVBAT

Returns the main power supply voltage level in millivolts
Codebase Revision: 0.3.0

Parameters: None

Output: The VBAT level in millivolts

AT+HWVBAT
3248
OK

AT+HWRANDOM

Generates a random 32-bit number using the HW random number generator on the nRF51822 (based on white noise).

Codebase Revision: 0.4.7

Parameters: None

Output: A random 32-bit hexadecimal value (ex. '0x12345678")

AT+HWRANDOM
0x769ED823
OK

AT+HWMODELED

Allows you to override the default behaviour of the MODE led (which indicates the operating mode by default).

Codebase Revision: 0.6.6

Parameters: LED operating mode, which can be one of the following values:

e o o o o o

or toggle.
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disable or DISABLE or 0 - Disable the MODE LED entirely to save power

mode or MODE or 1 - Default behaviour, indicates the current operating mode

hwuart or HWUART or 2 - Toggles the LED on any activity on the HW UART bus (TX or RX)

bleuart or BLEUART or 3 - Toggles the LED on any activity on the BLE UART Service (TX or RX characteristic)

spi or SPI or 4 - Toggles the LED on any SPI activity

manual or MANUAL or 5 - Manually sets the state of the MODE LED via a second comma-separated parameter, which can beon, off,
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Output: If run with no parameters, returns an upper-case string representing the current MODE LED operating mode from the fields above

# Get the curent MODE LED setting
AT+HWMODELED

MODE

OK

# Change the MODE LED to indicate BLE UART activity
AT+HWMODELED=BLEUART
OK

# Manually toggle the MODE LED

AT+HWMODELED=MANUAL,TOGGLE
OK

AT+UARTFLOW

Enables or disable hardware flow control (CTS + RTS) on the UART peripheral block of the nRF51822.
Codebase Revision: 0.7.0
Parameters: HW flow control state, which can be one of:

e 0N
o Off
e 0
o 1

Output: If run with no parameters, returns a number representing whether flow control is enabled (1) or disabled (0).

# Check the current flow control state
AT+UARTFLOW

1

OK

# Disable HW flow control

AT+UARTFLOW=off
OK
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Beacon

Adafruit's Bluefruit LE modules currently support the following 'Beacon' technologies:

e Beacon (Apple) via AT+BLEBEACON
e UriBeacon (Google) via AT+BLEURIBEACON (deprecated)
o Eddystone (Google) via AT+EDDYSTONE*

Modules can be configured to act as 'Beacons' using the following commands:

AT+BLEBEACON

Codebase Revision: 0.3.0

Parameters: The following comma-separated parameters are required to enable beacon mode:

Bluetooth Manufacturer ID (uint16_t)
128-bit UUID

Major Value (uint16_t)

Minor Value (uint16_t)

RSSI @ 1m (int8_t)

e o o o o

Output: None

# Enable Apple iBeacon emulation

# Manufacturer ID = 0x004C
AT+BLEBEACON=0x004C,01-12-23-34-45-56-67-78-89-9A-AB-BC-CD-DE-EF-F0,0x0000,0x0000,-59
OK

# Reset to change the advertising data

ATZ

OK

# Enable Nordic Beacon emulation

# Manufacturer ID = 0x0059
AT+BLEBEACON=0x0059,01-12-23-34-45-56-67-78-89-9A-AB-BC-CD-DE-EF-F0,0x0000,0x0000,-59
OK

# Reset to change the advertising data

ATZ

OK

AT+BLEBEACON will cause the beacon data to be stored in non-volatile config memory on the Bluefruit LE module, and these values will be
persisted across system resets and power cycles. To remove or clear the beacon data you need to enter the 'AT+FACTORYRESET' command in

command mode.

Entering Nordic Beacon emulation using the sample code above, you can see the simulated beacon in Nordic's 'Beacon Config' tool below:
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Moo 2 |l d @ 01:29

(IS Beacon config

nRF Beacon
IDENTITY

UuID 01122334-4556-6778-899a-abbccddeeffo
MAJOR (0)

MINOR 0

NOTIFY
EVENT Near [J-

ACTION Show Mona Lisa [l

ENABLED - oul |

Wireless by Nordic

AT+BLEURIBEACON

Converts the specified URI into a UriBeacon (http://adafru.it/edk) advertising packet, and configures the module to advertise as a UriBeacon (part

of Google's Physical Web (http://adafru.it/ehZ) project).
To view the UriBeacon URIs you can use one of the following mobile applications:

e Android 4.3+: Physical Web (http://adafru.it/edi) on the Google Play Store
e iOS: Physical Web (http://adafru.it/ed]) in Apple's App Store

Codebase Revision: 0.4.7

Parameters: The URI to encode (ex. http://www.adafruit.com/blog (http://adafru.it/ei0))

Output: None of a valid URI was entered (length is acceptable, etc.).
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http://google.github.io/physical-web/
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https://itunes.apple.com/us/app/physical-web/id927653608?mt=8
http://www.adafruit.com/blog

AT+BLEURIBEACON-=http://www.adafruit.com/blog
OK

# Reset to change the advertising data

ATZ

OK

If the supplied URI is too long you will get the following output:
AT+BLEURIBEACON-=http://www.adafruit.com/this/uri/is/too/long

URL is too long

ERROR

If the URI that you are trying to encode is too long, try using a shortening service like bit.ly, and encode the shortened URI.
UriBeacon should be considered deprecated as a standard, and EddyStone should be used for any future development. No further development
will happen in the Bluefruit LE firmware around UriBeacon.

Deprecated: AT+EDDYSTONEENABLE

This command will enable Eddystone (http://adafru.it/fSA) support on the Bluefruit LE module. Eddystone support must be enabled before the
other related commands can be used.

Codebase Revision: 0.6.6
Parameters: 1 or 0 (1 = enable, 0 = disable)
Output: The current state of Eddystone support if no parameters are provided (1 = enabled, 0 = disabled)

This command was removed in firmware 0.7.0 to avoid confusion. Use AT+EDDYSTONESERVICEEN in 0.7.0 and higher.

# Enable Eddystone support
AT+EDDYSTONEENABLE=1
OK

# Check the current Eddystone status on the module
AT+EDDYSTONEENABLE

1

OK

AT+EDDYSTONEURL

This command will set the URL for theEddystone-URL (http://adafru.it/fSB) protocol.
Codebase Revision: 0.6.6
Parameters:

e The URL to encode (mandatory)

e An optional second parameter indicates whether to continue advertising the Eddystone URL even when the peripheral is connected to a
central device

e Firmware 0.6.7 added an optional third parameter for the RSSI at 0 meters value. This should be measured by the end user by checking the
RSSI value on the receiving device at 1m and then adding 41 to that value (to compensate for the signal strength loss over 1m), so an RSSI
of -62 at 1m would mean that you should enter -21 as the RSSI at Om. Default value is -18dBm.

Output: Firmware <= 0.6.6: none. With firmware >=0.6.7 running this command with no parameters will return the current URL.
# Set the Eddystone URL to adafruit

AT+EDDYSTONEURL=http://www.adafruit.com

OK

# Set the Eddystone URL to adafruit and advertise it even when connected

AT+EDDYSTONEURL=http://www.adafruit.com,1
OK

AT+EDDYSTONECONFIGEN

This command causes the Bluefruit LE module to enable the Eddystone URL config service for the specified number of seconds.

This command should be used in combination with the Physical Web application from Google, available foAndroid (http://adafru.it/edi) or
iOS (http://adafru.it/edj). Run this command then select the 'Edit URL' option from the app to change the destination URL over the air.

Codebase Revision: 0.6.6
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Parameters: The number of seconds to advertised the config service UUID
Output: None
# Start advertising the Eddystone config service for 5 minutes (300s)

AT+EDDYSTONECONFIGEN=300
OK

AT+EDDYSTONESERVICEEN

Adds or removes the Eddystone service from the GATT table (requires a reset to take effect).
Codebase Revision: 0.7.0
Parameters: Whether or not the Eddystone service should be enabled or not, using on of the following values:

on
off
1
0

L]
L]
L]
L]

Output: If the command is executed with no parameters it will disable a numeric value indicating whether the servic